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Copyright

© STREAM-Labs. The content of this document must not be copied on any media without permission of
STREAM Labs Inc. in writing. Copying, distribution of partially or fully protected by copyright law
software VPlay, produced by STREAM-Labs, is forbidden. This rule applies to server and client software
VPlay as a whole; and to separate modules and files as well.

About Company

Stream Labs Inc. was founded in 1991 and currently is one of the leading Russian companies, working on
3 major lines of products:

- TV broadcast systems.
- Video surveillance systems.
- Systems for monitoring of TV broadcast.

Stream Labs Inc. is international company with offices in USA, Europe, Taiwan and Russia (Moscow). It
develops professional solutions for TV broadcast companies.

Stream Labs’ hardware and software developed for TV stations, satellite and cable TV providers gives
them excellent opportunity to automate TV broadcast, control quality of broadcast via automated
monitoring, implement interactive TV and advanced graphic design for TV programming.

Our company employs very creative team and our achievements in science and engineering during 15
past years have significantly enhanced the quality of our production. We deploy the most advanced
technologies for design and manufacturing.

We keep developing along with our customers. We participate in all major trade shows and conferences
around the world and we are perfectly aware of challenges, which our customers are facing. We have
been trying to be one step ahead and meet their expectation. Partnership with our clients combined
with professionalism is the key approach in our bid to success.

Our goal is to become a leading designer and manufacturer of highly professional solutions for TV
industry around the globe.

Main functions

- Concurrent and independent broadcast of several channels/overlays.

- Synchronized multichannel playout.

- Simultaneous IP/web and AV (video card output) broadcast with selectable bit rate and resolution.
- Client-server architecture. Control over server is being facilitated through client freeware.

- Playback of most common video file formats comingled in one playlist.

- Maintenance of log files; support of SNMP-protocol.
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VPlay 3 Installation

1. Insert USB dongle in usb port.

In order to make VPlay Server work, it is imperative to have USB key, manufactured by Stream Labs. This
USB key must always be inserted into the PC where VPlay Server is installed. In case if the key is not
inserted, then the software will not function.

2. SNMP protocol configuration.

Another important step before installation of VPlay is setup of SNMP protocol on your PC. This protocol
ensures communication between components of VPlay.

e Go to Control Panel -> Programs and Components -> Turn Windows features on or off

%g » Control Panel » All Control PanelItems » Programs and Features

Control Panel Home .
‘ Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, 1
& Turn Windows features on or
off Organize v
| Name £ Publisher
(?,\ pTorrent BitTorrent Inc.
[=77-Zip 9.20
(57 Ace Strearm Media 2.2.5-next Ace Stream Media
»ﬂAcronis True Image 2014 Acronis
B Adobe AR Adobe Systems Incorporated
E Adobe Download Assistant Adobe Systems Incorporated
B 2dobe Flash Player 15 Plugin Adobe Systems Incorporated
@Ashampoo Movie Studio v.1.0.17 Ashampoo GmbH & Co. KG
“& ASUS RT-N66U Wireless Router Utilities ASUS
2 AVCWare Video Editor 2 AVCWare

e Mark with flag component SNMP-protocol and WMI SNMP Provider; then press OK

[ Windows Feature- @MT
Turn Windows features on or off o
To turn a feature on, select its check box, To turn a feature off, clear its
check box, A filled box means that only part of the feature is turned on,

Remote Differential Cbmpression 73
[T | RIP Listener
@[] Services for NFS
= . Simple Network Management Protocol (SNMP)
| \WMI SNMP Provider L
[] | Simple TCPIP services (i.e. echo, daytime etc)
[] 1. Subsystem for UNDX-based Applications =
. Tablet PC Components
[] .. Telnet Client —
| [T 1 Telnet Server
[C] .. TFTP Client
710 Windmws Gadaet Platform ¥

e Then go to Control Panel -> Administration -> Services. In this window we are interested in 2 services:
SNMP service and SNMP trap. Right click on each service and select Automatic Start from the
«Properties»



str.am Labs INFINITE FREEDOM GINEAL

TELEWISION COMPUTER SYETEME

File  Action View Help

e 2EE =] b
& Computer Management (Local [ Seryices Actions
4 [} System Tools - ¥ R , . [ "
» @ Task Scheduler SNMP Service Name Description  Status  Startup Type  Log On As
{2 Event Viewer P i RPCEndpointMa.. ResolvesRP.. Started  Automatic Network S... More Actions
, &) Shared Folders g theservice; ‘% SecondaryLogon  Enables star... Manual Local Syste... e R
b :E Local Users and Groups . Secure Socket Tun... Provides su... Manual Local Service
» (%) Performance (i Security Accounts... Thestartup.. Started  Automatic Local Syste... More Actions »
) Device Manager Description: “ Security Center The WSCSV... Started  Automatic (D... Local Service
3 Storage EnblessimplENeniork % Sentinel HASP Lic.. Manages lic.. Stated  Automatic Local Syste...
48 3org Management Protocol (SNMP) ’ 9 %
_ &= Disk Management requests to be processed by this < Server Supports fil..  Started  Automatic Local Syste...
4 Services and Applications || computer. If this service is stopped,  (J; Shell Hardware De... Provides no.. Started  Automatic Local Syste...
W) Intemet Information Sei | the comg;:;rpwill be l:na[?lt:_to 3 SmartCard Mifsgesat.. Nianuial Local Seiice
¢ i rocess requests. If this service
ﬁ/i \S/;;;[é;ntrol |psdisabled, 'any::n{lcmhat aplicitly , mart Cardemc\... Allos thes.. Monual LcI Syste...
_ || depend on it will fail to start. ®3 SNMP Service Enables Sim... Automatic Local Syste...
> [ SQL Server Configuratic £ SNMP Trap Receives fran Stated  Automatic.  Local Serice
© Software Protection Enables the ... Automatic (D... Network S...
. SPP Notification S... Provides So.. Manual Local Service
% SQL Active Direct.. Enables inte... Disabled Network S...
4 SQL Server (SQLEX... Provides sto.. Started Automatic Network S... -
5 SQL Server Agent... Executes jo... Disabled Network S...
7 SQL Server Browser Provides SQ.. Started  Autornatic Local Service 2
7 SQL ServerVSSWr.. Providesth.. Started  Automatic Local Syste...
(. SSDP Discovery Discoversn.. Started  Manual Local Service |
“: Stream MultiEnco... Started Automatic Local Syste...
Superfetch Maintains a.. Started  Automatic Local Syste...
Systern Event Noti.. Monitors sy.. Started  Autoratic Local Syste...
i Tablet PC Input Se... Enables Tab... Manual Local Syste...
i Task Scheduler Enablesaus.. Started  Automatic Local Syste...
4 TCP/IP NetBIOS H... Provides su.. Started Automatic Local Service
i TeamViewer 9 TeamViewe.. Started  Automatic Local Syste...
(i Telephony Provides Tel... Manual Network S... -

Extended /( Standard /

e Reboot PC.

Note: all computers, on which you plan to install VPlay (regardless whether it is going to be server or
client), must undergo this procedure.

3. VPlay3 installation.
Launch VPlaySetup.exe, then select folder for installation and follow the installation wizard instructions.

etup - VPI

Welcome to the VPlay Setup
Wizard

This will install VPlay version 3.2014.09. 12 on your computer.

It is recommended that you dose all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

Cancel

4. Creating VPlay3 database.

At the end of the installation VPlayDBCreator window will appear. VPlayDBCreator is a utility for
creating a database in SQL Server for VPlay. If you incidentally missed this step, you can find
VPlayDBCreator.exe is in C:\Program Files\VSoft\Vplay folder.
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34 VPlay Data base creator _X
I SQL Database connection
Server name: A-SVIRSKIY\SQLEXPRESS - [ Check Database connection ]
Authentification: Windows Authentication v
& = [ Create VPlay database and tables
User name:
Password:
| DELETE VPlay database and tables ]
Report
O Check connection OK! Successfully established a connection to the server!
« T »

In «VPlay Data Base Creator» window:
e Click V¥ icon to select SQL Express server name.
e Press the button «Check Database connection» to check connection to SQL server.

e Pressthe button «Create VPlay database and tables» to generate a database in SQL for VPlay.

5. VPlay Server Settings.

Now we are ready to start configuring VPlay. Launch «VPlay Configurator»:



stream Labs INFINITE FREEDOM GREIAL

H TELEVISIDN COMPUTER BEYETEME

Common settings

Common settings

@ VPlay server info
Server ID: c9abaab6-88ce-4543-aeef-608bfacafesc Hostname: A-SVIRSKIY
SNMP tra|
2 Server name: VPlaySrv Location:

&ﬁ Server description:

External devices

& SQL Database connection

l.lvelnputs Server name: A-SVIRSKIY\SOLEXPRESS

g Authentification:  |SQL Server Authentication

User name: sa

Password:

VPlay server logs folder:

C:\VPlay3\Server\og

Configuration folder:

E:'\—\iPlay3\Server‘conﬁg

www.vsoft tv

I OK I OtMeHa } MpuMeHnTL ‘

In this window you need to connect to your database and specify server logs and configuration folder.

e VPlay server info — here you can assign server name, server location and server description (optional
fields)

e SQL Database connection — here you need to select your SQL Server name, authentication and check
Database connection

e VPlay server logs folder — here you specify the path to a folder which will contain server log files

e Configuration folder - here you specify the path to a folder which will contain server configuration files
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SNMP trap

Trap destinations Community name: Public

Gl=e)s)

Insert or delete trap destinations.
Trap destinations may be host names, IP addresses or IPX
addresses

] [ OTmMerHa ] | MpuMerHnTL [

In this window you add IP addresses of PC’s with client modules, server will intercept signals from clients
via SNMP service. If you install client modules on the same PC with server module, then you need to add
local IP address 127.0.0.1
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External Devices

Dbl. dick left mouse button for add new External device. For delete selected device press Delete” key

GPI Plugin (4 inputs via R5232) = External device
m GPI Plugin (4 inputs) Plugin name GPIPlugin (4 inputs)
Kramercontrol Pluqm description VSoft GP.I Plu?m :
m - s Device name GPIPlugin (4 inputs via R5232)
B Kramer P2000 Control | COMPart 5

SNy PR

[ ook | [ ‘OTMeHa ] ll‘lpuuenm'b ]

In this window you can add to configuration external devices compatible with VPlay, for instance GPI
Plugin or Kramer MTX (P2000 control).
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Live inputs

' = ]
7. VPlay Server Configurator =

W
@ (Step 4) Live inputs settings

Common settings

Q Dbl. dlick left mouse button for add new Live input. For delete selected input press Delete” key
SNMP trap ] Network Live Input = Live input properties
&ﬁ Live input device StreamLabs MS2 (Dev: 0, Channel: 1)
; StreamLabs MS2 (Dev: 0, Channel: 1) L{ve !nput name. ‘ StreamLabs MS2 (Dev: 0, Channel: 1)
External devices - TR Live input description MS2 SDI
& B Video format SD PAL 720x576, 25 frames
Enable analog video False
Live inputs Enable analog audio False
Enable deinterlace video False
- ~
Select Live device 5

AV (SDI) devices group (6)
ﬁstreamLabs MS2 (Dev: 0, Channel: 1)
StreamLabs MS2 (Dev: 0, Channel: 2)
mstreamLabs MH4M (Dev: 0, Channel: 1)
mstreamLabs MH4M (Dev: 0, Channel: 2)
StreamLabs MH4M (Dev: 0, Channel: 3)
ﬁstreamLabs MH4M (Dev: 0, Channel: 4)

Transport stream (IP) group (1) A
Network device

Create E l displayed in client

| [ omena | [ nomenms |

Image 1

In this window you can add video capture devices. These capture devices can be — capture card or IP
transport stream.

If you want to add capture card or IP ts as live input device press Create New button, select AV(SDI)
device or Network device and press Ok button.

On image 1 you can see Steam Labs MS2 card Live input properties:

e Live input device — capture device (optional)

e Live input name — capture device name (optional)

e Live input description — capture device description (optional)
e Video format — live input video signal standard and format

e Enable analog video — True for analog, False for SDI signal

e Enable analog audio — True for analog, False for SDI signal

e Enable deinterlace video — enable or disable deinterlacing
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On image 2 you can see Network live input properties:

» VPlay Server Configurator

©

Common settings

SNMP trap

g

External devices

7

Step v s sttiogs

Dbl. dick left mouse button for add new Live input. For delete selected input press Delete” key

F Network Live Input
. Transport Stream

= |Network live input

Live input device

Live input name

Live input description
Stream type

Url

Network interface
Host

Port

Steam (programm)
PID Stream

PID Video

PID Video Type

PID Audio

PID Audio Type
Enable deinterlace video

Network Live Input
Transport Stream
ubp

10.90.80.2
224141
1200

1640
1641
MPEG-2
1642
MPEG-2
False

Delete selected

Network live input

Live input name — the name of the live source

Image 2

Live input description — the description of the live source

Stream type — stream type UDP or RTP/RTSP

Url — specify RTP/RTSP url (e.g. rtsp://server.example.org:8080/test.sdp)

Network interface — specify network interface

Host — specify multicast or unicast ip address

Port — port
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Stream (program) — here you can choose certain program from MPTS (multiple program transport
stream) puc. 3

r w
Select stream g

Network interface: [10.90.90.2 v| Host(P): 224.1.4.1 Port: 1200 Start

B) Stream: PID: 1600 (0x640)
B Stream: PID: 1620 (0x654)
B Stream: PID: 1630 (0x65e)
BY Stream: PID: 1640 (0x668)
KJ Stream: PID: 1660 (0x67c)
: 1650 (0x69a)

(I I O g M e W
(8 C3 R C R R Eo R 63

Stream: PID: 1670 (0x686)
Stream: PID: 1650 (0x672)
Stream: PID: 1680 (0x&50)
: PID: 1610 (0x64a)
Stream: PID: 6660 (0x1a04)
Stream: PID: 6670 (0x 1a0e)
Stream: PID: 6610 (0x19d2)

8 O o B e T
e
i |l

W

o

Il

o

3

[ ok ][ cancel |

Image 3
PID Stream — stream identifier
PID Video — video stream program identifier
PID Video Type — video stream program identifier type
PID Audio — audio stream program identifier
PID Audio Type — audio stream program identifier type

Enable deinterlace video — enable or disable deinterlace video
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Channels
Q |V
Common settings
O Channel management operations implemented via the col
SNMP trap
Add Channel
Delete
Image 1
)‘é VPlay Server Configurator
© s
Common settings
O Channel management operations implemented via the context menu
N ERFY Channel 1 £ Channel properties
; g & Network output (Network device) Channel name Channel 1
; 34 (Stream Labs Alpha SDI (Dev: 0, Channel: 1) 2 Folders
& StreamLabs M52 (Dev: 0, Channel: 1) (Devio)
€8 GPT (GPI Plugin (4inputs) VSoft GPI Plugin) Channel log folder C:\VPlay3\Server\log
..&3¥ Kramer Control (Kramer P2000 Control VSoftf Channel work folder C:A\VPlay3\Channell
Channel time zone (UTC+02:00) Bunshtoc, Kues, Pura, ...
&= Video and Audio
Video format SD PAL 720x576, 25 frames
Audio 20
= Empty block settings
Empty block acton Black field
Media file
Live StreamLabs MS2 (Dev: 0, Channel: 1...
Deinterlace False
Scale LetterBox
< I ] »
[ OK ] [ OtMerHa ] | MpyMeHuTs .
Image 2

In this window you configure your channels, output sources, input sources and external devices.

Right click (image 1) and select Add Channel to create a channel. In the panel with properties (image 2)
you can configure properties of your channel:

e Channel name — your channel name

e Channel log folder — your channel log folder

e Channel work folder — your channel work folder (contain clips, logos and scenes)
e Channel time zone — your channel time zone

e Video format — your channel video signal standard and format
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Video format SD PAL 720x576, 25 frames =
SD PAL 720x576, 25 frames

SD NTSC 720x468, 29.94 frames

SD NTSC (Wide) 864x468, 29.94 frames
HD (720p) 1280x720, 50 frames

HD (720p) 1280x720, 60 frames

HD (1080i) 1920x1080, 25 frames

HD (1080i) 1920x1080, 30 frames

HD (1080i) 1920x1080, 59.94

HD (1080p) 1920x1080, 50 frames

HD (1080p) 1920x1080, 60 frames

e Audio — number of audio channels
e Empty block action — here you assign an action that will be executed if schedule encounters an empty
block or there is no schedule for current day:

Empty block acton Black field F
Black field
Media file
Live

Black field — black field will play
Media file — you can assign media file that will play in a loop mode
Live —you can assign live video input for play out

e Deinterlace — enable or disable deinterlacing

e Scale —you can select scale factor LetterBox, Anamorph or PanScan

Scale LetterBox I—J‘

Anamorph

PanScan

- &
Add Channel
""" ug Add External device » Devio
-0 L. Jin)
.... tp Add Live input > 5
- Add Output > hel: 1)

Delete
Image 3

Right click mouse on your Channel (Image 3) and select:

e Add External device —to add GPI or Kramer Controls
e Add Live input —to add capture cards
e Add Output —to add Network or Card output
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Network output properties

-
. VPlay Server Configurator

i
0 |./umm——
Common settings
Q Channel management operations implemented via the context menu
SNMP - & Channel 1 | & Output properties
65 i Lt | | ETTE et
amer Control (Kramer ontrol VSo! 2 v
StreamLabs MS2 (Dev: 0, Channel: 1) ( Devic) Encodes s_ettlngs Default encoder settings
External devices Network output (Network device) Network interface 10.90.90.2
e (Stream Labs Alpha SDI (Dev: 0, Channel: 1) Destination ip 224111
) i
Live inputs PID Video 1000
@) PID Audio 1001
K PID PCR 1000
Encoder settings
< m )

e QOutput name — network output name (optional)
e Encoder settings — here you can configure encoder (mpeg2 or h264) setting:

- —
Encoder settings M

Profile name:

Default encoder settings

Video Audio

Main( ept MPEG2 Video Encodel [MainCmcaptMPEGZAudioErmder vJ

MainConcept MPEG2 Video Encodér
MainConcept AVC/H. 264 Video Encoder l MPEG version (Layer): [Layer 2 V]
Level: [Man ,] Bitrate:

= Mode: [constant -
Mode: [Variable V] Bitrate (Kb/s): [160 ']

Bitrate (bit/sec):| 4000000 |
Min. rate (bit/sec): 4000000
Max. rate (bit/sec): 4000000
Image resize:

Enable image resize

(3 x[20 | pwes

(o J[ cancel |

Using this interface, you can select codec and its parameters (Level, Profile, Bitrate). Higher bit rate
provides better quality of the picture. Image resize option allows altering resolution of IP stream (in
pixels). If this option is disabled, then outgoing stream will have the default resolution, defined during
SD/HD channel configuration.
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e Network interface — your network card interface

e Destination ip — destination ip address where your transport stream is going to (receiver)
e Port—port

e PID Video - video packet identifier

e PID Audio — audio packet identifier

e PID PCR — program clock reference

Do not forget to apply and save all your settings.

Key Info

> VPlay Server Configurator g

Common settings

@ Key ID: 1175548528523719281 Trial period: 0 day(s): 1440 hour(s) Avaliable: 16 day(s): 1024 hour(s)

SNMP trap

‘& Channel 0

Enable IP Output True
= Channel 1

Enable IP Output True
&= Channel 2

Enable IP Output True
&= Channel 3

Enable IP Output True

[ OK ] [ OTMeHa ] | MpumeruTs |

In this window you can find information about your USB dongle. There are key ID number, number of
days before expiration (if you have a trial) and how many channels you have bought.
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VPlay Assets Manager

This module allows creating assets for the forward scheduling. Media library can be categorized, i.e.
news, movies, commercials, etc. Descriptions could be added to the files. Blocks, consisting from several
files could be created; entry and exit points could be designated; play back duration of separate files and
even blocks could be altered.

In order to enable VPlay Assets Manager, run VPlay Assets Manager:

1. Go to SQL Server tab (Image 1) and enter:

VPlay Assets Editor Settings

Common settings

F - '4 [; SQL server connect options

List of channels

SQL server connect
Options

Server name: I A-SVIRSKIY\SQLEXPRESS

Authentification: IWindows Authentication

User name:

Password:

Image 1
Server name — your SQL server name
Authentication — Windows Authentication
User name — blank
Password — blank
Press Check Database connection, Apply

2. Open List of channels menu and press Add channel (Image 2)
e Select your new channel and press OK
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VPlay Assets Editor Settings

Common settings

| A

y Select VPlay channel

SQL Server

Select channel: (Host name - Channel name)

Detailed information about the server:

Host:  A-SVIRSKIY
Name:  VPlaySrv
Description:

Location:
ServerID:  {5B9AF12D-C012-489F-A6D6-9EDO13E062EB}

Cancel

Image 2

e Select The working directory is the channel (e.g. — C:\VPlay3\Channell, Image 3), press Apply to

save changes
e Create shell link button will create shortcut on your desktop

VPlay Assets Editor Settings

Common settings

SOL Server é! Add VPlay output channels for the select before startup application

“tistof channels

Edit the channel list
Options

The workine

Image 3

3. Open Options menu to select VPlay asset editor options:
e Auto upload media clips to work folder
e Remove assets with media clip
e Show tooltips for block editor timeline

4. Press Ok and Restart application buttons.
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There are several ways to add assets (clips) in Asset Editor (Media Library)

First

e  Press Add button (Image 4). In Create new asset window type your clip name, description, choose
category and press OK.

- VPlay As
=

= Categor
B8 Asseteditor Create and edit asset property

24 sexch off Add

%
-]
Create new asset

-]

. Block assets editor Create and edit block assets property

4 sexch of Add

Timeline

B8 Block accets timeline Orag and drop assets for create block assets

Image 4

Select File source destination (Image 5), press Apply (Image 6) and Upload media file button (/mage 7)

< VPlay Assets Editor
Bl Channek \PlaySrv\Channel 1

= Category edtor B Auto make assets
BR Asseteditor Create and edit asset property

&Y Search o8 add off Remove By Copy

1 00:00:00:00 55000 s lknnmmn

% Block assets editor Create and edit block assets property

#§ Search o8 add

Timeline
B Block accets timeline Drag and drop assets for ceate block assets

L o,
BB Timeine 2 Udload

Ready

Image 5
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& VPlay Assets Editor
Channek: VPlaySrviChannel 1
== Category editor [~

B8 Asseteditor Create and edit asset property

&4 search... 8 add... o8 Remove By Copy B paste Apply

00:00:00:00 90:00:90:%0 o l(mnmnn wile

00:0 this is clip 1

Timecode

Asset media file

File source

File source

%t Block assets editor Create and edit block assets property

8% Search.. 8 add...

Timeline
B Block accets timeline Drag and drop assets for create block assets

e’

LW o,
B8 Timeline  E5 Upload

Ready

& VPlay Assets Editor
Channek: VPlaySrv\Channel 1
== Category editor [~

B8 Asset editor Create and edit asset property

&8 search... 58 Add... o8 Remove >3 U;ad - By Copy B paste

00:00:00:00 go:o0.00 ot I-(Hlllllllll\ wile

! this is clip 1

Timecode

Asset media file

File source

%t Block assets editor Create and edit block assets property

8% Search.. 8 add...

Upload
& Upload List of uploadable files

31.96 % | . wildelife - konws. C:\WPlay3 delife - Konus.wmy

S5 Timelne |28 Upload

Upload selected media files
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Second

Drag and Drop your clip in assets field (Image 8 Ne 1)

& VPlay Assets Editor
Channek VPlaySrv\Channel 1

== Category editor B Auto make assets
Asset editor Create and edit asset property

@4 Search .. 5B Add... o8 Remove By copy B paste

1 00:00:00:00 goiooico ot i l(nnunnn wile

" e

4 Block assets editor Create and edit block assets property

8 search.. =8 Add...

Upload
& Upload List of uploadable flles

B8 Timeline - £5 Upload

Ready

NUM

Image 8

Third

e Paste your clips in Channel Media folder and press Auto Make Assets button ().
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In asset editor, you can create and assign different categories to your clips.

Press Category editor button to enter category editor window:

Categorty editor Press Add button to create new category.

dd ... . . .
2 You can write category name, description and

Category list for current channel aSSIgn part|cu|ar C0|0r |abe|.

[ 1| [Common | Assetvithoutreference to the category of
L

film:

Edit selected category
Name:
Description:

Color label: IS 2

When you select your clip, you can change some of asset properties in the right panel:

. Common options
Common options

ru-Hobbit-An-Unexpected-
oisk.ru-Hobbit-An-Unexpec

e Name - selected asset name
e Description — selected asset description 2
e Category —selected asset category Sapgory
. Timecode
Timecode
e Timecode In — change timecode in of your clip manually

e Timecode Out — change timecode out of your clip Duration
manually Asset media file

e Duration — change duration of your clip
Asset media file

File source C:\V annel 1\Media \kinopoisk
Media Info
e File source —select a path to the clip Main

Here you can also check Media Info for selected clip.

Common options
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You can change timecode in and out for selected clip using preview window (Image 9).
ﬂ Asset editor Create and edit asset property

#% search... 22 Add... o2 Remove

Image 9

Just press Timecode In or Timecode Out buttons (Image 9 Nel or Ne2) to trim your clip or press Move
Start or Move End buttons (Image 9 Ne3 or Ne4) to get back to default clip timecode positions.

Block assets editor
Block assets editor is responsible for creating and managing blocks of clips.
To create block press Add button (Image 10 Ne1), write block Name, Description and select Category.
Then select your block (Image 10 No2) drag and drop clips (Image 10 Ne3) which you want to add to this
block on a block timeline (Image 10 Ne4).

> VPlay Assets Editor

B8 Asset editor Create and edit asset property

&4 search 28 Add oB Remove By Copy B poste

2 00:00:29:24 02009090 ford.mpg
frosta.mpg

garnier.mpg

»o»

B Block assets editor Create and edit bl

1 00:01:30:01 20070007 [ blocks  24.09.2014 8:50:
2 00:16:40:01 059 — P blocks  26.09.2014 9:04

a8 8B ugkoad
38 Tmelne 28 Upioad

Image 10
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VPlay Channel Manager

This module is dedicated for scheduling and monitoring of broadcast. It has to modes — play back and
editing. It supports Drag and Drop of files for easy scheduling and allows creating schedules for
unlimited future dates. Interface allows controlling of logotypes, scenes, secondary events, adding of
Live input, controlling GPI and matrix switchers.

In order to enable VPlay Channel Manager, run VPlay Channel Manager:

1. Goto SQL Server tab (Image 1) and enter:

VPlay Channel Manager Settings

Common settings

E!m — I* [; SQL server connect options

List of channels

SQL server connect
Schedule

Server name: I A-SVIRSKIY\SQLEXPRESS

Authentification: IWindows Authentication

User name:

Password:

Image 1
Server name — your SQL server name
Authentication — Windows Authentication
User name — blank
Password — blank
Press Check Database connection, Apply

2. Open List of channels menu and press Add channel (Image 2)
e Select your new channel and press OK
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VFPlay Channel Manager Settings

Common settings
SQL Server ol
“tist of channels

Schedule

Select VPlay channel

Select channel: (Host name - Channel name)

Detailed information about the server:

Host:  A-SVIRSKIY
Name: VPlaySrv
Description:
Location:
Server ID: {5B9AF12D-C012-489F-A6D6-9EDO13E062ER}

Cancel

Image 2

e Select The working directory is the channel (e.g. — C:\VPlay3\Channell, Image 3), press Apply to
save changes
e Create shell link button will create shortcut on your desktop

VPlay Channel Manager Settings

Common settings

SQL Server Q! Add VPlay output channels for the select before startup application

“tistof channels
Edit the channel list

Schedule

Image 3

3. Open Schedule menu to select Schedule editor setting:
e You can show or hide some columns in schedule list
e Choose intersection time between previous current and next day (ranges from 1 to 12 hours)

4. Press Ok and Restart application buttons.
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Schedule editor mode

In VPlay Channel manager press
to enter schedule editing mode.

1° VPloy Channel Manager
Bl Channel: \PlaySrviChanme 1
10000% Autoscroll[¥] Audio
Audio  Audo monitor control

e 01:13:48:06 00:00:00:00
01:13:48:06 i 09:24:25:08 »7000014  -08:10:37:02
200000000

A -] 1]
» > »> » 3 ]

22 centsabpa 2014, noHepensHUK R e

IS @ o
9- 9:24:06: s :00:00:
1 2140921 09:2406:15 47:59:50:00 00:00:00:00
Logo control
Logo Onar chamel bogo contral
Nologo Schedue logo Assgn logos

logotpe 1

stoscroll v/ (%] (21

Image 4
To add blocks in Block menu press Search button, select All Block Assets, press Search Now, OK.

Now you can drop your assets in your schedule to form day schedule. Do not forget to press Apply
button (Image 5) after editing.

1 VPay Channel Manager
[ S —
Asvets @ Autoscrol [V Block sssets

% Monktor Previen smets a
« Channel 1 00:01:12:24 00:01:18:04

Block assets details Description of the structe bock assets

1

£ WY YR &R 9

« » 22 centabpn 2014, noHegenbHNK

»
19 2014-09-22 10:53:31:14

I 20140922 10:500126 7 e

Empty Slot

Empty Slot
% Emply Slot
Empty Slot
Empty Slot
Empty Slot

Image 5

HINTS

In order to move your asset that has already been placed in schedule, select asset, hold Shift button on
a keyboard and left mouse button, and now you can drag this asset and change asset position.

In order to copy your asset that has already been placed in schedule select asset, hold Ctrl button on a
keyboard and left mouse button, and now you can drag this asset and copy it to different position.
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Empty block, Live event, GPI command and MTX control

By pressing insert button, you can add in your schedule:

e Empty block — insert empty block into your schedule
(you can configure empty block in VPlay Configurator)

e Live —insert live source into your schedule. You need to
select live source from drop down list and set live event
duration (HH:MM:SS:FR)

Insert empty block ...

Insert Live ...

Insert External control (GPI, DTFM, ...) ...

Insert Live channel to schedule

Select Live channel:

Set Live item duration:

e External control — insert GPl command to your schedule. You need to select GPI external control from
drop down list and assign input number.

Add External Event (Control)

Select external event

By pressing Add MTX or Scene button you can add in
your schedule:

Scenes and MTX Add, remove and move scenes and MTX

b (o) 5y I
. o) ¥ e s
e Scene (you can read more about creating scenes on page /
27) Add scenes ...
e Matrix control — insert matrix command to your Add Matrix control ...

schedule. You need to select Kramer control from drop
down list and assign switch command (input and output)

Add router control subitem

a Output: | 2 a
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VPlay Channel Manager interface in playback mode.

1= VPlay Channel Manager
B Channek: VPlaySrv\Channel 1

»

» a

8.
9.

Nouhs~wNR

%.46% Autoscroll[V/] Audio
Audio Audio monitor control

«« Channel 1 : ; :02:16: 00:00:14:03

12:39:18:04 : :20: 014  -00:00:00:09 1]

4
&
z

4 »>

(-X-X-X-X-X-X-X-J

21:00:00:00

1 okTabps 2014, cpepa = 4 2014-10-02 - 03:00:00:00

Logo control

Logo OnAir channel logo control
Nologo Schedule logo Assign logos

logotipe1

10:02 © 00:00:10:00 Empty block

0:02
33:20:02

t
£
4
£
£
c
4
4
t
£
g

NUM

Play by current server time

Play by selected time you can select the exact time to start your playout from

Play from selected position

Skip current clip

Jump to selected clip

Stop playout

Bypass (available for SteamLabs cards only) — switch composite or SDI signals in card directly
from Input to Output

Playout volume controls

No logo — disable all attached logotypes

10. Schedule logo — enable schedule logo mode
11. Assign logos — opens Assign logos window

HINTS

To position screen on currently playing clip in your schedule double click on current play list time (Image 1

Ne12).
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VPlay Control Panel
This is a server module, which provides preview of video output along with overlaying graphics;
monitoring of audio; reviewing of detailed information about the channel and monitoring of incoming

live signal. In addition, it allows stop/restart a server and stop/restart each channel (in case of
multichannel broadcast).

To start your VPlay server, go to VPlay Service Control and press Start button (/mage 1).

23 VPlayControl - VPlaySrv ()

VPlay Service Control

—~
I'V] m Progress Select Live: [© Restart | Select Output: I Restart
= b & E =1 ~ || i3 start Channel 1 (Network device) - || L3 start
A |_Istop | stop
VPlay Service control Live input control VPlay outputs
Image 1

To preview your output video go to Preview, in drop down Select AV source menu select your output
channel and press Start button (/mage 2).

23 VPlayControl - VPlaySrv ()
Preview VPlay Service Control
Select AV source:

jOutput: Channel 1 (Network device)

Start | Stop | Show/Hide Server/Channel | Enable
info

Preview source Capture Info Audio

Video: RGBA 720 x 576 @ 25; Audio: 2 ch

Frame counter: 3262; Frame time: 40.0000 ms.
Channel time: 06.06.2014 11:19:21.764

Play list time : 05.06.2014 14:00:06.694

Offset time : 21:19:15.070
kinopoisk.ru-Lucy-205218.mp4
kinopoisk.ru-Prometheus-122871.mp4

Image 2
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VPlay Scene Editor

This module allows creating static and animated logotypes, scenes, digital and analog clocks, static and
dynamic text.

In order to enable VPIlay Scene Editor, run VPlay Scene Editor, go to Tools & Settings -> Settings

Settings

A-SVIRSKIY\SQLEXPRESS v
Windows Authentication b

Select:

Server name — your SQL server name
Authentication — Windows Authentication
User name — blank

Password — blank

Press Ok.

To create logotype or scene go to File => New

1. To create logotype go to File => New —> Logo, select video standard and format for your output channel
and press Ok button.

Now you can add static image by pressing - Add image or you can add animation
by pressing - Add animation

VPlay Scene Editor supports only its own animation file format *.VPA. In order to
create files with this extension you need to use the built-in utility for conversion
«Image sequence converter».

] | Addimage |
- Image

° To create static logotype press Add image, select image file on your hard
drive and left click on a screen, where you want this image to be located. You can

change this image size and position using mouse or change it manually by typing
Position (x, y) and Size (width, height) in object properties window.
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Object properties window

Object properties o X
N Logo properties

Logo properties/Scene properties:

Name — here you can write your logo or scene name

Name

Video Format

Duration

Enable change duration
Show safe area

Safe area

New Logo

SD PAL 720x576, 25 frames
00:00:10:00

True

True

10

Video Format — here you can see your logo or scene selected
video standard and format

Image object properties
B Base properties

. . Name Image object #1
Duration — duration of the event Image file C:\Users\alexey.svirskiy\Pictu...
Keep aspect False
Enable change duration — enable or disable altering duration E Position (XY) 556, 41
. K Size (Width,Height 100, 100
of a scene from the editor schedule A
Duration 00:00:10:00
. Show delay 00:00:00:00
Show safe area — enable or disable safe area marker T Byt

Effect in duration 00:00
Safe area — specifies offset of safe area marker in percentage Effect out B8 Cut
points Effect out duration 00:00
B Object mask
Mask enabled False
Mask file

Image object properties
Base properties:
Name — selected object name

Image file — image file destination

Keep aspect — enable or disable aspect ratio for selected object

Cut
Position (X, Y) — here you can manually change position of selected object M Eada
Size (W, H) — here you can manually change width and height of selected |& Left
object -» Right
Duration — here you assign duration of selected object T Up

L Down

Show delay — here you assign delay for showing of selected object .

Left in rect
Effect in — enables special effect (Cut, Fade, Left, etc.) for selected object ! Right in rect
Effect in duration — specifies duration of enabled special effect for selected | =~ UPinred
object * Down in rect

Effect out — disables special effect (Cut, Fade, Left, etc.) for selected object

Effect out duration — specifies duration of disabled special effect for selected object

Object mask:
Mask enabled — enable or disable mask for selected object

Mask file — mask file destination
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To create animated logotype press Add animation, select *.vpa file on your

D! @ Newlogo X hard drive and left click on a screen, where you want this animation to be
= located. You can change image size and position using mouse or change it
= manually by typing Position (x, y) and Size (width, height) in object properties
g = Add animation] window.
Animation * .

To create *.vpa file you need to use Image sequence converter. Go to Tools &
o Settings -> Image Sequence converter.
3 1. Select your output channel video standard

2. Select source you can choose tga sequence or video file from

If you choose video file, you can select what part of video clip you want to trim to create *.vpa

animation.

VPlay animation converter

video standart:

SD PAL 720x576, 25 frames v

), Select source file:

Duration: QOO0 0D000

stination file:

3. Select destination folder for your *.vpa file
4. Press start button to create *.vpa animation file

Important:

You have to save logotypes directly in your Channel Logos folder (e.g. C:\VPlay3\Channell\Logos).

2. To create Scene go to File => New —> Scene, select video standard and format for the channel and press

OK button.

@#) 3 .w @ Ne

i
=

1 < {BL il ®

"I+ Add static text
Static text

e To create static text press Add static text and left click on a [ﬂﬁ
screen, where you want this text to be located. You can change this
text size and position using mouse or change it manually by typing | =1
Position (x,y) and Size (width, height) in object properties window. E
e To create scroll text press Add scroll text and left click on a
screen, where you want this text to be located. ==/
xg:j | Add scroll text ]

Scroll text

bt
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Static text object properties

Text style

Style — select predefined style (you can create additional
styles in VPlay Text Style Editor)

Description — predefined style description

Save text style — save current text style in database,
assign style name and description

Object properties

Effect out B8 Cyut

Effect out duration 00:00

B Object mask
Mask enabled False
Mask file

B Text style
Style
Description

Edit text
Edit text — edit currently selected text

Save text style

Text Format

B Edit text
Font —.current text font ' Edit text Text string object
Font size — current text font size - Wm
Bold — makes font bold S Arial
Italic - makes font italic Eiaie 0
Underline — underlines current text Bold Falce
Wrap — wraps up current text Ralic Forca
Text align — aligns current text left, right, center Undetline False
Paragraph align — aligns current paragraph Near, Far, Wrap True
Center Text align Left (leading)
Paragraph align Near
Text color, outline, shadow S FE
Color B Color
Text Color — current text color Text Color | Biiiia

Alpha — specifies current text transparency Alpha
Outline Outline
Enable Outline — enables or disables text outline Enable outline
Outline Color — outlines color Jutline C
Outline Alpha — specifies outline transparency
Outline Size — specifies outline size

Shadow

Enable shadow — enables or disables shadow
Shadow Color — shadow color

Shadow Alpha — specifies shadow transparency
Angle — specifies angle of deviation shadow
Offset — specifies shadow distance

Scroll text object properties

Edit text

Static text — enables or disables static text

Data source — select data source for scroll object
Data source description — scroll description of object data source
Edit text — disabled when static text is false

Scroll

Speed — specifies text scroll speed

Approximate Duration — approximate duration of scroll text
Direction — specifies scroll direction left or right
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You can create two types of text scroll:

1. Press Add scroll text and left click on a screen, where you want this scroll text to be located. In object
properties window in Edit text row select Static text — True
This will be standard scroll text with one style that will scroll only once.

Scroll text string object
2. Press Add scroll text and left click on a screen, where you want this scroll text to be located. In object
properties window in Edit text row select:

- Static text — False
- Data source — Scroll text data source

Header Sample

How to create ticker you can read on page 37 — 42.

e To create digital clock press Add digital clock and left
click on a screen, where you want to place this clock.
In object properties window you can adjust font, font
color, style, etc.

e To create analog clock press Add analog clock. Add

analog clock window will appear:

G =y Add digital do(kl - Background — select clock background image

PRSI EEN

' =) Add analog clock )
Analog clock

1210

Digital clock - Hour - select hour hand
] - Minute — select minute hand
- Second — select second hand

Press OK button and left click on a screen, where you want clock to be located.

Important:

You need to save scenes directly in your Channel Scenes folder (e.g. - ;
C:\VPlay3\Channell\Scenes). © S
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Attaching Logotypes and Scenes to clips in VPlay Channel Manager
Attaching Logotype
Open VPlay Channel Manager, go to Logo control panel (Image 1 Nel) and press Assign logos button
(Image 1 No2). Assign logos window will appear (Image 1 Ne3).
Click Slot 1-16 and assign logotype to selected slot (Image 1 Ne4).

« Channel 1

00:27:13:08 00:32:46:17

09:27:13:07

o 00:00:10:00 3

00:00:10:00

Image 1

3.1 You can assign specific logotype for particular clips in your schedule:

Enter Schedule editor mode
Select clip or clips you want to assign your logotype to, then press Select logo slot button (Image 2 Ne1)
and select logotype

Press Apply button to save changes

Schedule logo
Leave Schedule editor mode and in Logo control panel press Schedule logo
button

« Channel 1 00:42:20:03 00:17:39:22

09:42:20:02 1:33:41:16 -01:51:21:14

. W

&Y Y& & 9

+ 1 okrabps 2014, cpena

P

00:00:10:00 200070
00:02:31:03 300000
00:00:10:00 200090
»  00:00:10:00 5000
00:00:30:00 20:000ead

00:00:10:00 2000004

3
v
I3
¥
3
.
"
®

00:00:20:00 20000

00:00:29:24 S0

G 00:00:30:00 200000

2 00:13:39:

Image 2
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3.2 You can assign one selected logo for all clips in your schedule:
e In Logo control panel select desired logotype (Image 3 Ne1) to enable Manual logo mode (Image 3 No2)

1" VPlay Channel Manager
B Channet Wiy

e 00:06:23:21 00:07:15:22

14:03:30:18 11:44:50:11 02:18:40:07

1 oxrabpa 2014, cpepa

£

20141001 MA31623 000031
20141001 14154891 0.0
2014-10.01 14:16:48:12

0-01 14:17:18:14

S —S— — 1 ) R — - —

2014-1001 14:17:48:16

Image 3

Attaching scenes

1. Open VPlay Channel Manager and enter Schedule editing mode.
2. Select clip you want to assign your scene to, then press Add MTX or Scene button, choose Add Scene
(Image 4 Ne1) and select scene you want to add.

1 vPlay Channel Manager

« Channel 1

13:00:33:09

= ®
» 1 oxrsbps 2014, cpena

113 A e |100:00:30:00

20141001 13:
114

w >
83 Assets Ustofsssets Scenes and MTX ?
1 sexh

115 2014-10-01 14 5 .00 00:00:00:0 . - S.enes and MTX Add, remove and move scenes ond MTX

2014-10-01 14:13:16:2 : 0 Pa v

116

117 o4 0:0 : v VDA e Add sceres
118 2014-10-01 14:16:48:12 :30:02 ° » adé Matrix conwl

119 14:17:18:14

|

120 - 216 | 00: Empty Slot
21 Y : %  Empty Slot
122 - o - . Empty Slot
123 efnt R . Empty Slot
124 01:00:00:00 % Empty Slot

Image 4

If you want, you can assign several scenes to one clip. To edit scene

offset time, duration and static text content, press Edit button.
Edit

Edit selected item
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VPlay Text Style Editor

This module allows creating text styles.

In order to enable VPlay Text Style Editor, run VPlay Text Style Editor, go to SQL Server tab and enter:

VPlay Text Style Editor Settings <

Common settings

', } SQL server connect options

' SQL Server

SQL server connect

Server name: [ A-SVIRSKIY\SQLEXPRESS v
Authentification: lWindows Authentication v

|
User name: l ‘
|

Password: l

Server name — your SQL server name
Authentication — Windows Authentication
User name — blank

Password — blank

Press Check Database connection button, then Ok and Restart application buttons.

% VPlay Text Style Editor
SAMPLE TEX

Text style Selectand edit text style Text style Edit selected text style

Refresh Add style Remove

xt background color
Enable ind

Image 1
To create style press Add style button (Image 1).

Write your style name in Name field and style description in Description field.
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Now you can select your style and change text style properties.

Text Style Text style Edit selected text style
Font — current font yext style
Font
Font size — current font size Font size
Bold
Bold — makes font bold Italic
g o Underline
Italic - makes font italic AR Y
. . Enable fill colo
Underline — underlines current text Dt .
Color
Alpha 2
Text color
Text background color
Enable fill color — enable or disable text fill color Enable fill background On
Background [] 192;0; 157
Text Color — current text color Alpha

Text outline
Enable

Alpha — specifies current text transparency
Text background color

Enable fill background — enables or disables text

background color Text shadow
Enable
Background — current text background color

Alpha - specifies current text background
transparency

Text outline

Enable — enables or disables current text outline

Color — current text outline color

Alpha — current text outline transparency

Size — outline size

Text shadow

Enable — enables or disables current text shadow
Color — current text shadow color

Alpha — current text shadow transparency

Angle (Degree) — shadow angle

Offset — shadow offset

Do not forget to press Apply button.
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VPlay Content Template Editor

This module allows creating content holder templates.

In order to enable VPlay Content Template Editor, run VPlay Content Template Editor, go to SQL Server

tab and enter:
VPlay text content template editor settings x

Common settings

l SQL Server

| } SQL server connect options

SQL server connect I

Server name: [ A-SVIRSKIY\SQUEXPRESS «|
Authentification: |Windows Authentication v |
User name: I i
Password: I |

Server name — your SQL server name

Authentication — Windows Authentication

User name — blank

Password — blank

Press Check Database connection button, then Ok and Restart application buttons.

X VPlay Content Template Editor

Field 1| FIELD Field 3

71

Text content tempate Edit the text content template Property Edit the template fields, styles and and text offset
Refresh Add template Remove template Add field

Field 1

New template -1
New template -1

Continue...

Offset left

Image 1
To create content holder template press Add template button.

Write your template name in Name field, template description in Description field.
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Select Show mode from the drop down menu:
Continue show — scroll one text after another

Page break show — second scroll text will appear only when the first one disappears

[Show mode

IPage break show

Now you can select a template and change content
holder template properties.

Property Edit the template fields, styles and and text offset

Add field
By pressing Add field button, you can add more text

style fields to your current template.

Field 1

Style — here you select text style for your field
Offset left — here you can assign prefix offset values

Offset right — here you can assign postfix offset values




INFINITE FREEDOM GIEAL)

TELEWISION COMPUTER SYETEME

VPlay Text Content

This module is responsible for composing of dynamic text, here you fill your ticker content.

In order to enable VPlay Content Template Editor, run VPlay Content Template Editor, go to SQL Server
tab and enter:

VPlay text content template editor settings 28

| Common settings
[ .
l SQL Server | | } SQL server connect options

SQL server connect

Server name: [ A-SVIRSKIY\SQUEXPRESS «|

Authentification: iWindows Authentication ~ ]

User name: i 1

Password: ‘ ‘

Y oo

o [ [ |

Server name — your SQL server name
Authentication — Windows Authentication
User name — blank

Password — blank

Press Check Database connection button, then Ok and Restart application button.

VPlay Text Content

s Tools ... %> Refresh

Text Object ID: 1|

L qwe qwe Property Setand edit text item property

Image 1

To add text object tab press Tabs (Imagel Ne1) button. Choose your text object and Switch Use Tab to
On.

You can create text object in VPlay Scene Editor, just go to Tools & Settings -> Text content press Add
button and write text object name and description. Press Ok button.
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To create a ticker press Add button (Imagel No2). Now you can assign to your ticker a template you
have created in VPlay Text Content.

Property Setand edit text item property

Text item properties
Text item property

Date-Time Begin
Date-Time End

Date-Time period

Date-Time Begin — set ticker begin time

Date-Time End — set ticker end time

Num of repeat
Priority
Date-Time period — switch on and off date-time Text teplate
mode Text template
Field 1
Field 2
Number of repeat — set the amount of repeat runs S

(0-10000)

Priority — set ticker priority (1-10, 0 — undefined)

Text template — select text content template
Text template
Field 1 — here you enter content to your ticker (Image 2)

The number of fields depends on your content template.

B VPlay Text Content
5 Tools ... v %5 Refresh

Heade sample Eody sample[d IR ESAEFTNTE

Text ObjectID: 1
I qwe qwe %3 Property Setand edit textitem property
t item property

Heade sample
Body sample

late

t template

Ready

Image 2
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VPlay Report

This module creates AS-RUN log and contains play back history — what video had been broadcasted,
timestamp, duration, etc.

In order to enable VPlay Report, run VPlay Report, go to SQL Server tab and enter:

VPlay Report Settings

| Common settings =

| SQL Server LZ, SQL server connect options

SQL server connect

Server name: I

Authentification: ‘ Windows Authentication

User name:

Password:

Server name — your SQL server name
Authentication — Windows Authentication
User name — blank

Password — blank

Press Check Database connection button, then Ok and Restart application button.

| Reportassets Displays the report in the table view

2014-10-06 12:57:27:07  (.().39.1Q  00:00:00:00 Cine ySeries- Gazapos en las series historicas

Clip
Clip 20141006 13050220 - : 00:00:00:00 20 _AVI

Cine y Series- Gazapos en las series...

Tone.avi

2014-10-06 09:19 00:00:00:00 =
Live - < : : ~ = Live 0

- 2014-10-0 9 00:00:00:00 20_AVI_Tone ]
Clip - o :00:05:04 9009, | 29. o 20_AVI_Tone.avi

Clip 20141006 14474611 . E 00:00:00:00 20_AVI_Tone 20_AVI_Tone.avi
Clip

2014-10-06 14:47: 00:00:00:00

00:00:01:22
2014-10-06 14:47:50:03  0.00.0.0) ~ 00:00:00:00 garnier

ford.mpg

Clip garnier.mpg

. 2014-10-06 14:47:52:05 00:00:00:00
Clip 4 =

kinopoisk.ru-Edge-of-Tomorrow-19...
Cip | a1 00:¢ 20 || SF09-00:09 /D - ew_level s promo_KHL_TV_HD_Amedia_ver2...
Clip ALY IR 14 ®  00:00:01:10  29:00:00:00 o . < kinopoisk.ru-Edge-of-Tomorrow-19...
Clip 20141006 1475719 4. .03 00:00:00:00 frosta

= 2014-10-06 14:48:27:21 00:00:00:00 garnier
Clip E s -

frosta.mpg

garnier.mpg
Clip 2014-10-06 14 00:00:03:02  ©0:00:00:00 kinopoisk.ru-Edge-of- Tomorrow-193948
Clip 00:00:01:11  90:00:00:00 Promo_KHL_TV_HD Amedia_ver2_new_level su-. pro o KHL_TV_HD_Amedia_ver2...

CHp P 2 1e:0a 24 00:00:01:22  90:00:00:00 20_AVI Tone 20_AVI_Tone.avi

kinopoisk.ru-Edge-of-Tomorrow-19...
2014-10-06 14:48

2014-10-06 14:48: 00:00:00:00 frosta

Clip 00:00:02:08

4:48:39: :00:00: inopoisk.ru-Hobbil cted-Journey- The-...
2014-10-06 14:48:39:07  (0.00.(4.1Q  00:00:00:00 kinopoisk.ru-Hobbit pected-Journey-Th

frosta.mpg

Clip kinopoisk.ru-Hobbit-An-Unexpecte...

NUM

Image 1

To view the report select your channel from drop down menu (Image 1 Nel), select filter criteria (Image
1 No2) and press Query button (Image 1 Neo3) to generate a report.

You can assign additional search criteria using search panel (Image 1 Ne4): Search report for all assets;
Search by asset name; Assign asset time interval.
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VPlay Monitor

VPlay Monitor is intended for playout control of one or several channels by system operator or any

other member of staff.

It provides both — visual control by «preview» window and sound indicators, and instrumental control
through TV channels service information, progress-bars, schedules, system logs, etc. The operator
tracks out all changes in a schedule made by media-planners of the channel, what significantly declines

possibility for human errors.

In order to enable VPlay Report, run VPlay Report, go to SQL Server tab and enter:

VPlay Monitor Settings
Common settings

~5QL Server g {} SQL server connect options

Channel configuration
SQL server connect

Server name: I A-SVIRSKIY\SQLEXPRESS

Authentification: |SQL Server Authentication

User name:

Password:

Server name — your SQL server name
Authentication — SQL Server Authentication
User name — your SQL Server user name (e.g. sa)

Password — your SQL Server password

Press Check Database connection button and go to Channel configuration.

VPlay Monitor Settings

Common settings
QL Server @ Create and edit monitor configuration
“Channel configuration

Configuration editor
Create new configuration

Configuration lig
Select configuration lavout:

Layout preview:

Preview layout]

Cancel

In Channel Configuration press Add button, select Type 0 if you want to
want to monitor more channels, just select desirable amount of channels from drop down menu) and

press Ok button.

monitor one channel (if you
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VPlay Monitor Settings

Common settings

SQL Server &@ Create and edit monitor configuration

[ Channel configuration 1
Configuration editor

Configuration list Edit current selected configuration

Configuration-1 Configuration
figur,

Channek: 1

[ Create shell Ink |

Preview layout

Now select your Configuration from Configuration list and select a channel for monitoring from Server
GUID ID. Press Ok and Restart application button.

o VPlay Monitor
Autoscroll D E] [E] ﬁ'l v

Pr d udp: =1
Channel created!

-00:00 09
Counter HH:MM:SS:FR Count down HH:MM:SS:FR

00:06:50:05 00:12:748:22

® < » Y m1 »

64.29 %  Autoscrol

Time zone: (UTC+02:00) Bunbhioc, Kueg, Pura, Codmsa, TanmH, XenbcuHku
Cine y Series- Gazapos en las series histdricas - 17-09-14.mp4
Live 0

0- Javier Nart - 15

pos en icas - Cine eries- Gazapos en
Live 0
El retrato- er Nart - El retrato- Javier Nart - 15
Live 0

Javier Nart - 15 El retrato- Javier Nart - 15

2014-10-07 1
2014-10 4-10 0 0 4 - Gazapos 5 - Cine y Series- Gazap:

2014-10-07 10:36:06:10

Now you can monitor your Channel.
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Internet streaming

Using VPlay3 software you can organize broadcasting to World Wide Web.
Mostly broadcasters use Adobe Media Server, Windows Media Server or Wowza Streaming Engine.
The general schema of broadcast to Internet consists of following steps:

1. Forming play-out in VPlay3.

2. Encoding outgoing video signal from Vplay3. For this purpose, you may use either free software
Microsoft Expression Encoder or Adobe Flash Media Encoder.

3. Organizing internet broadcast. For Microsoft Expression you have to use Windows Media
Server; for Adobe Flash Media Encoder you have to use Adobe Flash Server (these servers are
paid products and not included in our package). These servers distribute streams to internet
users.

Conclusion. Step one and step two can be completed using our software (VPlay3) and free encoding
software Microsoft Expression Encoder or Adobe Flash Media Encoder.

Step three is yours responsibility. We do not provide support for media server configuration!!!
If you want to setup broadcast to the internet, you have to resolve step three first.

There are also another solutions for streaming stream to the internet: XSplit software and Wowza
Streaming Engine.

XSplit is a partially free live streaming software. You can create live stream to a wide variety of
recipients. XSplit Broadcaster works with all popular live stream providers — Justin.tv, Livestream,
Twitch, UStream, Youtube.

Wowza Streaming Engine is unified streaming media server software. Wowza Streaming Engine can
provide streaming to various types of playback clients and devices simultaneously, including Adobe
Flash player (Adobe RTMP, Adobe HDS), Microsoft Silverlight player, Apple QuickTime Player
and iOS devices (iPad, iPhone, iPod Touch), 3GPP mobile phones (Android, BlackBerry OS, Symbian,
etc.), IPTV set-top boxes (Amino, Enseo, Roku, Streamit and others),and game consoles such
as Wii, Xbox, and PS3.
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Adobe Flash Media Live Encoder 3.2

Adobe Flash Media Live Encoder (FMLE) — is a media encoder that captures and streams audio and video
in real time to Adobe Media Server (AMS) software or Flash Video Streaming Service (FVSS).

FMLE is a desktop application that connects to AMS or FVSS via Real Time Messaging Protocol (RTMP) to
stream live video to connected clients. Clients connect to the AMS or FVSS server and view a stream
through a Flash Player.

VPlay server includes virtual driver for compatibility with Adobe Flash Media Live Encoder, which allows
broadcasting in RTMP.

B3 Adobe Fiash Media Live Encoder 2 =X

File  Help

Input 5 Output

: ¥ InputVideo ¥ OutputVideo ¥ Audio
Output v

¥ Audio Stream to Flash Medi T

VPlayCapture D VPlayCapture L rtmp:/flocalhost/live

H.264 v A For Mp3

Frame Rate: = 15.00 v fps annels:  Stereo Stream: livestream
720x576 ¥ a atic S 22050 z Connect

Bit Auto Adjust

1 v 200 w Kbps

¥ Save to File 'sample.fiv
Limit By Size

Limit By Duration

Deinterlace Timecode

Setting up Adobe Flash Media Live Encoder

Run Adobe Flash Media Live Encoder 3.2. In drop down menu select:
Video — Device: VPlayCapture

Audio — Device: VplayCapture

Depending on your computer specs and connection speed, you should adjust the encoding settings to
provide best quality and press Start button.

Video Settings
Device

This is your video capture device source. You need to select VPlayCapture here.
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Format

You can select H.264 or VP6 encoder.

Frame Rate

This must match the frame rate of the device (VPlayCapture).
Input Size

This is capture video size.

Maintain Aspect Ratio This should be checked - it will ensure that the output ratio stays the same as the
input ratio to ensure that an image is not shrunk or stretched.

Bit Rate

This should be set based on your level of available upstream bandwidth as well as the expected
downstream connection speed of your audience.

Output Size

This should match the size of the embedded player you are encoding for and should be the same size or
smaller than the input size.

Crop

By cropping you can remove any black bars surrounding a picture.
Audio Settings

Device

This is your audio capture device source. You have to select VPlayCapture here.
Format

This is your audio formats mp3, AAC, HE-AAC

Channel

This specifies the channel option, mono or stereo.

Sample Rate

This specifies the audio sample rate in Hz.

Bit Rate

This specifies the audio encoding bit rate, for higher quality broadcast recommended parameters are
96Kbps or 128Kbps, for lower quality broadcast recommended parameters are 48Kbps or 64Kbps.

Streaming settings
Stream to Flash Media Server

Here you have to enter your FMS url, backup URL and stream.
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Microsoft Expression Encoder 4
Microsoft Express Encoder is an advanced audio and video-encoding and live-broadcasting application
that captures and streams in real time to Windows Media Server. It can create video streams for
distribution via Microsoft Silverlight.

Setting up Microsoft Express encoder

Open express encoder and select Live Broadcasting project.
Go to File -> Add Live Source

In Video Device drop down menu select VPlayCapture.

In Audio Device drop down menu select VPlayCapture.
Select an output tab on the right hand panel.

When an encoder is providing a stream for a broadcast, it can either push the stream to the server or
the server can pull it from the encoder. When pushing a stream, the encoder initiates the connection to
the server; on the other hand, when pulling the stream from the encoder, the server initiates the
connection.

For Push distribution

e Mark the Publishing Point check box

e Enter details for your streaming account in the Location field

e Click Connect button to test the connection

e A separate window should now appear, requesting your username and password. Enter the
username and password for your stream

For Pull distribution

e Mark the Broadcast check box

e Choose a port number for the broadcast

e Choose a maximum number of connections
e C(lick the Test button

Click Start in the central panel to start broadcasting on your Windows Media Streaming account.

See Microsoft documentation for more details.
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XSplit Broadcaster

XSplit is a partially free live streaming software. You can create live stream to a wide variety of
recipients. XSplit Broadcaster works with all popular live stream providers — Justin.tv, Livestream,
Twitch, UStream, Youtube. You can use XSplit software to broadcast your VPlay playout.

) Local Recording O

l Add channel... » I {* Custom RTMP
Remove channel.., Jtv  Justintv
) > | Wl Livestream
9 ? Local Streaming
Twitch
 UStream

...... RO . More...
SRR

ource Y ~ Scene 1
[ screen region (10, 6) - 1895 x 1032 ene Scene 5 I Scene 9
[¥] vPlayCapture
Scene 2 Scene 6 Scene 10
Scene 3 Scene 7 Scene 11
Add ~ Remove Settings AV Scene 4 Scene 8 Scene 12

Setting up XSplit Broadcaster

Just run XSplit and select VPlayCapture as Scene Source. Assign desirable settings, select streaming
service and star broadcasting.

See XSplit Broadcaster documentation for more details.
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Wowza Streaming Engine

Wowza Streaming Engine is unified streaming media server software. Wowza Streaming Engine can
stream to various types of playback clients and devices simultaneously.

You can capture VPlay3 UDP MPEG-TS using Wowza, convert it to MPEG-DASH, Apple HLS, Adobe RTMP,
Adobe HDS, Microsoft Smooth Streaming or RTSP/RTP and broadcast to the internet.

You can read more about capturing UDP streams using Wowza here:

http://www.wowza.com/forums/content.php?37

Test Players @

Server | 10.90.90.2:1935 Application  live

Stream myStream

MPEG DASH Apple HLS Adobe RTMP Adobe HDS MS Smooth

Server: rtmp://10.90.90.2:1935/live Stream: stream.stream Stop |

Status: Started playing stream.stream. WIN 15,0,0,152 {Flash-AS2)


http://www.wowza.com/forums/content.php?37

